Notices

© Agilent Technologies, Inc. 2008-2009

No part of this manual may be reproduced in any form or by any means (including electronic storage and retrieval or translation into a foreign language) without prior agreement and written consent from Agilent Technologies, Inc. as governed by United States and international copyright laws.

Manual Part Number

N5105-90004

Edition

April 2009

Printed in USA

Agilent Technologies, Inc.
3501 Stevens Creek Blvd.
Santa Clara, CA 95052 USA

Warranty

The material contained in this document is provided “as is,” and is subject to being changed, without notice, in future editions. Further, to the maximum extent permitted by applicable law, Agilent disclaims all warranties, either express or implied, with regard to this manual and any information contained herein, including but not limited to the implied warranties of merchantability and fitness for a particular purpose. Agilent shall not be liable for errors or for incidental or consequential damages in connection with the furnishing, use, or performance of this document or of any information contained herein. Should Agilent and the user have a separate written agreement with warranty terms covering the material in this document that conflict with these terms, the warranty terms in the separate agreement shall control.

Technology Licenses

The hardware and/or software described in this document are furnished under a license and may be used or copied only in accordance with the terms of such license.

Restricted Rights Legend

U.S. Government Restricted Rights. Software and technical data rights granted to the federal government include only those rights customarily provided to end user customers. Agilent provides this customary commercial license in Software and technical data pursuant to FAR 12.211 (Technical Data) and 12.212 (Computer Software) and, for the Department of Defense, DFARS 252.227-7015 (Technical Data - Commercial Items) and DFARS 227.7202-3 (Rights in Commercial Computer Software or Computer Software Documentation).

Safety Notices

CAUTION

A CAUTION notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in damage to the product or loss of important data. Do not proceed beyond a CAUTION notice until the indicated conditions are fully understood and met.

WARNING

A WARNING notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in personal injury or death. Do not proceed beyond a WARNING notice until the indicated conditions are fully understood and met.
### Contents

1 **Installation and Setup**
   - Unpacking ........................................... 2
   - Ordering Accessories ................................. 3
   - Options ........................................... 4
   - Meeting Environmental and Electrical Requirements .................................. 6
     - Environmental conditions (operating) ........................................... 6
     - Ventilation Requirements ........................................... 6
     - Line Setting Requirements ........................................... 6
     - Connecting the AC Power Cord ........................................... 7
   - Installing the PXB in an Equipment Rack ........................................... 7
   - Connecting a USB Mouse ........................................... 8
   - Connecting an External USB Keyboard ........................................... 8
   - Connecting an External VGA Monitor ........................................... 8
   - Connecting External Instruments to the PXB ........................................... 8
     - External Instrument Firmware ........................................... 8
     - External Instrument Connection Diagrams ........................................... 9
   - Powering On the PXB the First Time ........................................... 11
     - Initializing the System ........................................... 11
     - Power-up Self Test ........................................... 13
     - Anti-virus Software and Firewalls ........................................... 13
     - Power Option Settings ........................................... 13
   - Shut Down Mode ........................................... 14
     - To Shut Down Using a Mouse ........................................... 14
     - To Shut Down Using the Power Hardkey ........................................... 14
     - Unplugging the PXB ........................................... 14
   - Connecting the PXB to LAN ........................................... 15
   - Licensing the PXB ........................................... 15
   - Proper Use and Cleaning ........................................... 16
     - Cleaning Suggestions ........................................... 16
   - Online Documentation ........................................... 17

2 **Front and Rear Panel Features**
   - Front Panel ........................................... 20
     - Front Panel Hardkeys ........................................... 20
     - Touch Screen Display ........................................... 23
     - USB Connectors ........................................... 23
   - Rear Panel ........................................... 24
     - System Clock Rear Panel Connectors ........................................... 25
     - CPU Host Controller Rear Panel Connectors ........................................... 27
Contents

I/O Board Connectors ................................................. 28

3 Using the PXB

Keys to Success with the PXB ........................................ 32
  External Instrument Firmware ................................ 32
  Power ............................................................ 32
  Cables ............................................................ 32
  10 MHz Reference ............................................... 32
  Digital I/O Bus .................................................. 32
  LAN and GPIB .................................................... 33
  PXB Firmware .................................................... 33
  PXB Licensing ..................................................... 33
  PXB Unexpected Errors ......................................... 33
  External Instruments ............................................. 34
  MXA as an RF Input Device ................................... 34
  MXG/ESG as an RF Output Device ............................ 34
  MXG/ESG ALC Settings ......................................... 34
  Power Calibration ................................................ 34
  MIMO Configurations .......................................... 35
  Play .............................................................. 35
  Fader .............................................................. 35
  Touch Screen ..................................................... 35

Administering User Accounts ......................................... 36
  Existing User Accounts ........................................ 36
  To Create a New Account ...................................... 37
  To Change the User Account Properties ...................... 38

Hard Drive Partitioning and Use .................................... 40

Licensed Firmware .................................................... 40

Running Self Test ..................................................... 41

PXB System Information .............................................. 45
  Locating the Computer Name ................................ 45
  Checking the IP Address ....................................... 45

Remote Desktop: Using the PXB Remotely ......................... 46
  Overview of Remote Desktop Operation ....................... 46
  Setting Up Remote Desktop Operation ....................... 46
  Running a Remote Desktop Session ............................ 48

Agilent Technologies Recovery System ............................ 53
  Agilent Recovery System Procedure .......................... 53

Returning the PXB to Agilent Technologies ........................ 57

Removing Sensitive Data ............................................. 57
## Contents

### 4 Using Microsoft Windows XP
- Microsoft Windows XP Considerations ........................................... 60
- On Screen Keyboard ........................................................................... 61
- User Installation of Software ............................................................... 61
  - Installation of Third Party Software .................................................. 61
- Capturing/Printing Displays and Windows. ........................................... 62
- Windows Security ................................................................................ 62
  - Spyware Protection ............................................................................ 62
- System Backup ...................................................................................... 62

### 5 PXB Basic Configuration Setup
- One Channel Generate Configuration Setup ............................................. 64
  - 1. Basic Introduction and Turn On ....................................................... 64
  - 2. External Instrument Registration ..................................................... 64
  - 3. External Instrument Assignment ..................................................... 66
  - 4. Baseband Generator Setup and Waveform Download ......................... 68
  - 5. Output I/O Setup ............................................................................ 69
  - 6. Signal Generator Setup ................................................................... 71
  - 7. Waveform Playback ....................................................................... 72

### 6 Safety and Regulatory Information
- Warnings, Cautions, and Notes .............................................................. 74
- General Safety Considerations .............................................................. 74
- Lifting and Transporting ....................................................................... 74
  - Weight and Dimensions .................................................................. 74
- Instrument Markings ............................................................................ 75
- Toxic or Hazardous Substance and Elements Table ................................. 76
- Regulatory Information ....................................................................... 76
  - Certification ...................................................................................... 76
  - Assistance ......................................................................................... 76
  - Declaration of Conformity ................................................................. 76
  - Statement of Compliance .................................................................. 77
  - Compliance with Canadian EMC Requirements ..................................... 77
  - Compliance with Canadian Standards Association Requirements ............ 77
  - Compliance with German Noise Requirements ..................................... 77
- Contacting Agilent Technologies ............................................................ 77
Documentation Overview

Quick Start Guide
- Receiving the Instrument
- Accessories and Options
- Environmental & Electrical Requirements
- Basic Setup
- Instrument Configuration
- Remote Desktop Operation
- Instrument Verification
- Regulatory Information

Online Documentation
- Release Notes
- Installing and Licensing
- Tutorials and Examples
- User Interface Operation
- Basic Instrument Procedures
- Waveform Files
- Remote Operation
- Programming
- SCPI Commands
- Basic Troubleshooting

Guided Service and Support
- PXB Troubleshooting
- Replaceable Parts
- Assembly Replacement
- Post-Repair Procedures and Performance Verification
- Safety and Regulatory Information

Other Documentation
- N5106A PXB MIMO Receiver Tester Error Messages (N5105-90012)
- N5106A PXB MIMO Receiver Tester Firmware Upgrade Guide (N5105-90013)
- N5106A PXB MIMO Receiver Tester Security Features (N5105-90014)

All documentation is available on the internet at http://www.agilent.com/find/pxb. Always refer to this web site for the most recent and up-to-date documentation.
1 Installation and Setup

- **Unpacking** on page 2
- **Ordering Accessories** on page 3
- **Options** on page 4
- **Meeting Environmental and Electrical Requirements** on page 6
- **Installing the PXB in an Equipment Rack** on page 7
- **Connecting a USB Mouse** on page 8
- **Connecting an External USB Keyboard** on page 8
- **Connecting an External VGA Monitor** on page 8
- **Connecting External Instruments to the PXB** on page 8
- **Powering On the PXB the First Time** on page 11
- **Shut Down Mode** on page 14
- **Connecting the PXB to LAN** on page 15
- **Licensing the PXB** on page 15
- **Proper Use and Cleaning** on page 16
- **Online Documentation** on page 17
Unpacking

1. Inspect the shipping container for damage.
   
   Signs of damage can include a dented or torn shipping container or cushioning material that indicates signs of unusual stress or compacting.

2. Carefully remove the contents from the shipping container and verify that your order is complete.

   **NOTE**  
   Depending on the number of hardware installed options the instrument may weigh up to 33 kg (70 lbs.). The PXB should be lifted by at least two people. If two people are not available, use a mechanical lift to lift the PXB. The PXB should be transported using a rolling cart.

   The following items are included with the PXB:
   
   • N5106A PXB MIMO Receiver Tester Quick Start Guide
   • N5106A PXB MIMO Receiver Tester Documentation DVD [Data Sheet, Guided Service and Support, Configuration Assistant, and Online Documentation (Help)]
   • N5106A PXB MIMO Receiver Tester Firmware DVD
   • Signal Studio and Baseband Studio Software DVD
   • Three–prong C19 AC power cord (specific to geographic location)
   • SMB (female) to BNC (male) 50Ω cable, 1.0m (39.37 in.)

3. Verify that the hardware options you ordered are included with the shipment by checking the serial number label on the rear of the PXB and the packing literature included with the shipment.
## Ordering Accessories

You can purchase accessories or documentation at: [http://www.agilent.com/find/pxb](http://www.agilent.com/find/pxb).

If you do not have access to the Internet, contact your Agilent Technologies representative.

<table>
<thead>
<tr>
<th>Description</th>
<th>Part Number</th>
<th>Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>N5106A PXB MIMO Receiver Tester Data Sheet^a</td>
<td>5989–8971EN</td>
<td></td>
</tr>
<tr>
<td>Cable, SMB (female) to BNC (male), 50Ω 1.0m (39.37 in.) (external reference/trigger cable)</td>
<td>8121–1789</td>
<td>720</td>
</tr>
<tr>
<td>Cable, Digital Bus (approximately 3 meter)</td>
<td>N5101–60003</td>
<td></td>
</tr>
<tr>
<td>N5106A PXB MIMO Receiver Tester Firmware DVD</td>
<td>N5105–10001</td>
<td></td>
</tr>
<tr>
<td>N5106A PXB MIMO Receiver Tester Quick Start Guide^a</td>
<td>N5105–90004</td>
<td></td>
</tr>
<tr>
<td>Documentation DVD^a:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• N5106A PXB MIMO Receiver Tester Quick Start Guide</td>
<td>N5106A</td>
<td>CD1</td>
</tr>
<tr>
<td>• N5106A PXB MIMO Receiver Tester Guided Service and Support</td>
<td>N5105–90005</td>
<td></td>
</tr>
<tr>
<td>• Configuration Assistant</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• N5106A PXB MIMO Receiver Tester Online Documentation (Help)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>USB Accessory Kit</td>
<td></td>
<td>181</td>
</tr>
<tr>
<td>Includes the following USB enabled devices:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Keyboard</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Optical Mouse</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Disk Drive (DVD–ROM/CD–RW)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rack Mount Flange and Front Handle Kit</td>
<td>N5106A</td>
<td>1CP</td>
</tr>
<tr>
<td>Rack Mount Slide Kit</td>
<td>N5106A</td>
<td>1CR</td>
</tr>
</tbody>
</table>

^a. All documentation is available on the internet at [http://www.agilent.com/find/pxb](http://www.agilent.com/find/pxb). Always refer to this web site for the most recent and up-to-date documentation.
Options

The following tables list the options available for the PXB:

- “Baseband Hardware Options”
- “IO Hardware Options”
- “Built-in Firmware Options”
- “Hardware and Firmware Bundled Options”
- “Software Bundle Options”
- “Upgrade Options”

<table>
<thead>
<tr>
<th>Baseband Hardware Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>N5106A-611</td>
<td>one DSP block on one baseband generator card</td>
</tr>
<tr>
<td>N5106A-612</td>
<td>two DSP blocks on one baseband generator card</td>
</tr>
<tr>
<td>N5106A-613</td>
<td>three DSP blocks on two baseband generator cards</td>
</tr>
<tr>
<td>N5106A-614</td>
<td>four DSP blocks on two baseband generator cards</td>
</tr>
<tr>
<td>N5106A-615</td>
<td>five DSP blocks on three baseband generator cards</td>
</tr>
<tr>
<td>N5106A-616</td>
<td>six DSP blocks on three baseband generator cards</td>
</tr>
<tr>
<td>N5106A-617</td>
<td>seven DSP blocks on four baseband generator cards</td>
</tr>
<tr>
<td>N5106A-618</td>
<td>eight DSP blocks on four baseband generator cards</td>
</tr>
<tr>
<td>N5106A-619</td>
<td>nine DSP blocks on five baseband generator cards</td>
</tr>
<tr>
<td>N5106A-620</td>
<td>ten DSP blocks on five baseband generator cards</td>
</tr>
<tr>
<td>N5106A-621</td>
<td>eleven DSP blocks on six baseband generator cards</td>
</tr>
<tr>
<td>N5106A-622</td>
<td>twelve DSP blocks on six baseband generator cards</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>IO Hardware Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>N5106A-632</td>
<td>One IO card that provides two IO ports. Each IO port has both digital IO and analog I/Q.</td>
</tr>
<tr>
<td>N5106A-634</td>
<td>Two IO cards that provide four IO ports. Each IO port has both digital IO and analog I/Q.</td>
</tr>
</tbody>
</table>
### Built-in Firmware Options

<table>
<thead>
<tr>
<th>Option Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>N5106A-EFP</td>
<td>Baseband generation</td>
</tr>
<tr>
<td>N5106A-JFP</td>
<td>Calibrated AWGN</td>
</tr>
<tr>
<td>N5106A-QFP</td>
<td>Fading with SISO channel models</td>
</tr>
<tr>
<td>N5106A-RFP</td>
<td>Mobile WiMAX MIMO channel models</td>
</tr>
<tr>
<td>N5106A-TFP</td>
<td>LTE MIMO channel models</td>
</tr>
</tbody>
</table>

### Hardware and Firmware Bundled Options

<table>
<thead>
<tr>
<th>Option Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>N5106A-2B2</td>
<td>2x2 MIMO baseband generation and channel emulation bundle</td>
</tr>
<tr>
<td></td>
<td>This bundle consists of the N5106A with options 616, 634, EFP, JFP, and QFP.</td>
</tr>
</tbody>
</table>

### Software Bundle Options

<table>
<thead>
<tr>
<th>Option Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>N5106A-LTE</td>
<td>LTE MIMO software application bundle</td>
</tr>
<tr>
<td></td>
<td>This bundle adds the N5106A-TFP LTE MIMO channel models and Signal Studio model N7624B 3GP LTE with options 6FP, GFP, and RFP.</td>
</tr>
<tr>
<td>N5106A-WMX</td>
<td>Mobile WiMAX MIMO software application bundle</td>
</tr>
<tr>
<td></td>
<td>This bundle adds the N5106A-RFP WiMAX MIMO channel models and Signal Studio model N7615B 802.16 WiMAX with options 6FP, EFP, QFP, and RFP.</td>
</tr>
</tbody>
</table>

### Upgrade Options

<table>
<thead>
<tr>
<th>Option Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>N5106AK-031</td>
<td>Enables one DSP block on one baseband generator card.</td>
</tr>
<tr>
<td>N5106AK-032</td>
<td>Adds one baseband generator card.</td>
</tr>
<tr>
<td>N5106AK-034</td>
<td>Adds one IO card that provides two IO ports. Each IO port has both digital IO and analog I/Q.</td>
</tr>
</tbody>
</table>
Meeting Environmental and Electrical Requirements

**WARNING**  If this product is not used as specified, the protection provided by the equipment could be impaired. This product must be used in a normal condition (in which all means for protection are intact) only.

**Environmental conditions (operating)**

- for indoor use (unless otherwise specified)
- altitudes < 10,000 feet (3,000 meters)
- 10 to 40 °C temperature (unless otherwise specified)
- maximum relative humidity 80% for temperatures up to 31 °C, decreasing linearly to 50% relative humidity at 40 °C

**CAUTION**  This product is designed for use in Installation Category II and Pollution Degree 2 per IEC 61010 Second Edition and 664 respectively.

**Ventilation Requirements**

Ventilation holes are located on the side panels of the PXB. To ensure proper air flow through the PXB, do not allow these holes to be obstructed.

**CAUTION**  When installing the PXB in a cabinet, the convection into and out of the instrument must not be restricted. The ambient temperature (outside of the cabinet) must be less than the maximum operating temperature of the instrument by 4 °C for every 100 watts dissipated in the cabinet. If the total power dissipated in the cabinet is greater than 800 watts, then forced convection must be used.

The PXB has intake fans are on the left side of the instrument and exhaust fans are on the right side. If multiple instruments are placed side-to-side, the hot exhaust air from one instrument becomes the input air for the instrument next to it which may cause it to overheat.

**Line Setting Requirements**

**CAUTION**  The PXB has autoranging line voltage input. Ensure that the supply voltage is within the specified range.

<table>
<thead>
<tr>
<th>Voltage:</th>
<th>100/120 VAC nominal</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>220/240 VAC nominal</td>
</tr>
<tr>
<td>Frequency:</td>
<td>50/60 Hz nominal</td>
</tr>
<tr>
<td>Power:</td>
<td>&lt; 875 W typical</td>
</tr>
<tr>
<td></td>
<td>1075 W maximum</td>
</tr>
</tbody>
</table>
Connecting the AC Power Cord

**WARNING**  This is a Safety Class 1 Product (provided with a protective earthing ground incorporated in the power cord). The mains plug shall only be inserted in a socket outlet provided with a protective earth contact. Any interruption of the protective conductor inside or outside of the product is likely to make the product dangerous. Intentional interruption is prohibited.

The front panel *Power* hardkey is only a standby switch; it is not a line switch.

Install the instrument so that the detachable power cord is readily identifiable and is easily reached by the operator. The detachable power cord is the instrument disconnecting device. It disconnects the mains circuits from the mains supply before other parts of the instrument. The front panel switch is only a standby switch and is not a LINE switch. Alternatively, an externally installed switch or circuit breaker (which is readily identifiable and is easily reached by the operator) may be used as a disconnecting device.

**CAUTION**  The Mains wiring and connectors shall be compatible with the connector used in the premise electrical system. Failure to ensure adequate earth grounding by not using the correct components may cause serious injury and instrument damage. Always use the three-prong AC power cord supplied with the PXB.

**CAUTION**  Before switching on this instrument, make sure

- The line voltage selector switch is set to the voltage of the mains supply
- The correct rating service breaker
- The supply voltage is in the specified range

Prior to connecting the AC power cord follow these steps:

1. Ensure that the supply voltage is in the specified range.
2. Ensure that the power cord is not damaged.
3. Install the PXB so that one of the following is readily identifiable and easily reached by the operator:
   - AC power cord
   - alternative switch
   - circuit breaker
4. Insert the mains plug into a socket outlet provided with a protective earth grounding.

**Installing the PXB in an Equipment Rack**

To prepare an equipment rack for mounting a PXB, you must install rails in the rack to support the weight of the instrument. You may use either Option 1CP or Option 1CR to secure the PXB in the rack. Follow the instructions provided with each kit.

Position the instrument so that the disconnecting device is within easy reach.
Connecting a USB Mouse

A mouse can be used for fine control of the PXB graphical user interface. The mouse may be connected to any one of the eight Type A USB connectors of the PXB (the four front panel or the four rear panel (USB Slave) connectors).

**NOTE**
If a USB device is not recognized, try unplugging it from the PXB and plugging it back in. If the PXB will not boot up, try removing all USB devices until the boot up process has completed. For USB device problems, refer to the *N5106A PXB MIMO Receiver Tester Guided Service and Support* document.

Connecting an External USB Keyboard

A keyboard can be used as an input to the PXB. The keyboard may be connected to any one of the eight Type A USB connectors of the PXB (the four front panel or the four rear panel (USB Slave) connectors).

**NOTE**
If a USB device is not recognized, try unplugging it from the PXB and plugging it back in. If the PXB will not boot up, try removing all USB devices until the boot up process has completed. For USB device problems, refer to the *N5106A PXB MIMO Receiver Tester Guided Service and Support* document.

Connecting an External VGA Monitor

The monitor connector on the rear panel of the PXB allows you to connect an external VGA monitor.

Connecting External Instruments to the PXB

The PXB connects to a variety of external instruments for testing. Included with the PXB is a cable for locking the frequency references between the PXB and the external instruments that are connected. This section contains single-in-single-out (SISO) front and rear panel connection setups for the PXB and the external instruments. For multiple-in-multiple-out (MIMO) setups, additional external equipment is used following the same basic interconnection scheme shown in this section. For additional information on MIMO setups, refer to Example Configuration Setups tutorial in the online documentation.

**NOTE**
The block diagrams in the PXB user interface show which IO ports to use for each specific configuration.

External Instrument Firmware

The PXB requires that the external instruments have the following firmware installed:

- E4438C ESG signal generator: C.05.23 or later
- N5182A MXG signal generator: A.01.44 or later
- N9020A MXA signal analyzer: A.01.64 or later

Refer to the instrument’s *Users Guide* for information on downloading the latest firmware releases.
External Instrument Connection Diagrams

The following setup diagrams assume that the PXB is the controller and uses GPIB as the interface between instruments. Optionally the PXB can control the instruments through the LAN. To use LAN connections, ignore the shown GPIB cable connections and connect each instrument to the LAN.

PXB to ESG or MXG Signal Generator Setup

**Figure 1-1  PXB to ESG or MXG Signal Generator**

MXA to PXB to ESG or MXG Signal Generator Setup

**Figure 1-2  MXA to PXB to ESG or MXG Signal Generator**
Installation and Setup
Connecting External Instruments to the PXB

PXB to Digital Signal Interface Module Setup

Figure 1-3  PXB to Digital Signal Interface Module

PXB to ESG or MXG Signal Generator Analog I/Q Setup

Figure 1-4  PXB to ESG or MXG Signal Generator Analog I/Q
Powering On the PXB the First Time

**CAUTION** During boot up of Microsoft® Windows XP® or of the PXB firmware, do *not* press keys on the front panel, rotate the RPG knob, or connect a USB device. Doing so may lead to a front panel lockup state. Wait until the PXB firmware is running and all activity has stopped for at least one minute.

Initializing the System

**CAUTION** The PXB must remain on through the system initialization operation. The system displays an initial message (Figure 1-5), that provides the details.

The system initialization may take up to 20 minutes to complete and will perform three system reboots. If a power interruption occurs during this process, select the appropriate action from the following list:

- If the process has not performed the first reboot, restart the process after the power has been restored.
- If the process has gone beyond the first reboot, perform the recovery steps, refer to the “Agilent Technologies Recovery System” on page 53.

1. To start the initialization process, press the PXB **Power** hardkey located on the front panel.
   The **Power** LED changes from yellow to green.

**Figure 1-5** Windows XP Professional Setup Wizard
2. After reading the warning message that appears (see Figure 1-5), ensure that Microsoft Windows XP Professional is highlighted and press the PXB front panel Enter hardkey.

3. When the Windows XP license agreement is displayed, read the terms and accept the agreement.

**NOTE**  You must accept the agreement to continue the system initialization. If you do not accept the agreement, the PXB shuts down and the next time you turn it on the initialization process starts from the beginning.

For more information about the License Agreement for Windows XP, see the questions and answers about the End-User License Agreement topic in the Microsoft Windows XP Help and Support documentation.

4. In the license agreement dialog box, click Next.

5. Follow the ensuing prompts.

Prior to the third reboot, the system initialization displays a message indicating that the system will perform a reboot in two minutes (see Figure 1-6) and after the reboot, the system launches the PXB user interface.

**Figure 1-6  Windows XP Reboot**

![Windows XP Reboot Image]
**Power-up Self Test**

During the PXB interface launch, the PXB performs a self test, which includes a configuration check. If an error occurs during the self test, the PXB displays an error message. If this occurs, refer to the *N5106A PXB MIMO Receiver Tester Guided Service and Support* document or contact Agilent Technologies.

**Anti-virus Software and Firewalls**

The PXB is Windows-based and may be subject to virus exposure when connecting to the network/internet. We have anti-virus requirements to ensure that your PXB arrives to you virus free. To ensure a continued virus free product status, we recommend you follow these steps:

- When connecting to the network/internet, ensure it is a trusted site.
- Ensure all removable or writable media are virus free before use.
- Install anti-virus protection on your PXB

No anti-virus software is shipped with the instrument. It is recommended that you install anti-virus software if your instrument will be connected to the LAN. Check with your IT department for their recommendations.

The instrument is shipped with the Windows XP firewall enabled. Do not modify the default network settings as this may cause improper operation. However, you will have to temporarily disable the firewall if you install licenses from a remote computer.

**Power Option Settings**

The PXB is sent from the factory with the following power option settings:

- The monitor is set to shut off after one hour of inactivity.
- The hard disk drive (HDD) is set to shut off after three minutes of inactivity.
- The System standby is set for Never.

The PXB does not support the Microsoft Windows XP Standby or Hibernate modes.

**CAUTION**

To prolong HDD life, Agilent recommends that you leave the power option settings at their default values.
Shut Down Mode

In the Shut Down mode, the current instrument state is not automatically saved before the PXB is powered off. The Power LED will change from green to yellow when the power is off. When the PXB is again powered on, a full system boot up is performed followed by automatically launching the PXB user interface.

CAUTION If you cannot operate the mouse or keypad, shut down the PXB by pressing and holding the Power hardkey for at least four seconds. Repeated shut downs in this manner may damage the hard drive and should be avoided.

To Shut Down Using a Mouse
1. Move the mouse cursor to the bottom edge of the display to activate the Windows task bar.
2. From the Windows task bar, click Start > Shut Down to display the Shut Down Windows dialog box.
3. Click the drop-down arrow located beneath the What do you want the computer to do? prompt.
4. Select Shut down > OK to perform the action.

Figure 1-7 Shut Down Windows Dialog Box

To Shut Down Using the Power Hardkey

CAUTION Do not press and hold down the Power hardkey as this performs an improper shutdown.

1. Firmly press the front panel Power hardkey and release it. The instrument immediately begins the shutdown process.

Unplugging the PXB

Remove the power cord from the PXB only when the Power LED is yellow (in Shut Down mode). The Power LED will remain yellow for several seconds after the power cord has been removed.

CAUTION Removing the power cord while the Power LED is green may cause damage to the HDD and corrupt the operating system. It may also damage the PXB’s FPGA code.
Connecting the PXB to LAN

Microsoft Windows supports fixed Internet Protocol (IP) addressing and Dynamic Host Configuration Protocol (DHCP). The PXB Windows XP factory default setting is DHCP. This system queries the LAN server and assigns a dynamic IP address to the device on a network. Like the USB devices, the LAN cable has the capability of "hot" connects and disconnects. In addition, there is a visual indicator in the Windows task bar area that indicates LAN connection status and a network wizard that provides assistance with network and internet connections. For more information, refer to the Microsoft Windows XP Help and Support documentation.

NOTE To add your instrument to a domain or to set up the networking configuration, contact your IT department. This setup is custom for each company.

Licensing the PXB

Additional firmware licenses can be ordered after your initial purchase of the PXB. Once you purchase a license you will receive an Entitlement Certificate. In order to receive the license you must redeem this certificate at the Agilent License Redemption website:

http://www.agilent.com/find/softwarelicense

You will promptly receive an e-mail with the license file attached. There are two methods to install the license.

• You can install the license on the PXB using a USB storage device.
• You can run the Agilent License Manager software from an external PC connected to the PXB through a LAN connection.

NOTE If you are unable to connect to the PXB or if you receive an error message when trying to connect, temporarily disable the Windows® Firewall. From the Windows task bar, click Start > Control Panel > Windows Firewall > Off.

For more information on licensing, refer to the “Online Documentation” on page 17.
Proper Use and Cleaning

**WARNING**  The PXB cover protects against physical contact with internal assemblies that contain hazardous voltages, but does not protect internal assemblies against contact with liquids. Ensure that liquids are positioned away from the PXB. Personal injury may result if the PXB is not used as specified. Unspecified use impairs the protection provided by the equipment.

**WARNING**  No operator serviceable parts inside. Refer servicing to qualified personnel. To prevent electrical shock, do not remove covers.

Cleaning Suggestions

**Touch Screen Panel**

**CAUTION**  Do not use products that contain Ammonia, Phosphates, or Ethylene Glycol. Their use can result in the optical impairment of the touch screen panel or damage the functionality. Check the product content label carefully.

**NOTE**  Glass or plastic cleaning products that contain one to three percent isopropyl alcohol by volume are within the acceptable limits for cleaning the resistive touch screen panel.

- Use a soft lint-free cloth.
- The cloth may be used dry or lightly dampened with a mild cleaner.
- Do not use a cleaner that contains more than 10% isopropyl alcohol.
- Never apply the cleaner directly to the touch screen surface.
- Wipe the surface gently. If there is a directional surface texture, wipe in the same direction as the texture.
- Avoid contact with the edges of the film, glass, and the flex tail of the touch screen surface.
- Use a cleaner that has a pH of 7.0 (neutral).
- Do not use chemicals such as paint thinner, acetone, toluene, xylene, or kerosene.
- The following are suitable cleaning products for the touch screen surface:
  - Klear Screen™
  - Glass Plus® Glass and Surface Cleaner
Front and Rear Panel Connectors

**WARNING** Cleaning the connectors with isopropyl alcohol should be done with the instrument’s power cord removed and in a well ventilated room. Allow all residual isopropyl alcohol moisture to evaporate and the fumes to dissipate prior to energizing the instrument.

- To ensure good connections, regularly clean the instrument’s front and rear panel connectors with isopropyl alcohol.

**Instrument Cover**

**WARNING** To prevent electrical shock, disconnect the N5106A power cord from the mains supply before cleaning. Use a dry cloth or one slightly dampened with water to clean the external case parts. Do not attempt to clean internally.

- To prevent dust build-up that could potentially obstruct ventilation, periodically clean the instrument’s cover with a dry cloth or a cloth lightly dampened with water.
- Do not clean any internal surface of the instrument.

**Online Documentation**

Use the online documentation to reference programming and user information. Help information is available in English.

You can access the online documentation by pressing the **Help** hardkey on the front panel or selecting the **Help** menu in the PXB firmware. The help is also available on the documentation DVD that is shipped with the PXB. There is no hardcopy of the online documentation available.

All documentation is available on the internet at [http://www.agilent.com/find/pxb](http://www.agilent.com/find/pxb). Always refer to this web site for the most recent and up-to-date documentation.
2 Front and Rear Panel Features

- Front Panel Hardkeys on page 20
- Touch Screen Display on page 23
- USB Connectors on page 23
- System Clock Rear Panel Connectors on page 25
- CPU Host Controller Rear Panel Connectors on page 27
- I/O Board Connectors on page 28
Front Panel

Front Panel Hardkeys

The front panel hardkeys enable the user to define, monitor, and manage the input and output characteristics of the PXB user interface.

Figure 2-1  Front Panel Hardkeys
1. Ctrl (Control)
Functions as a modifier key. When the Ctrl hardkey is pressed in conjunction with another key, it performs a special operation.

2. Alt (Alternate)
Functions as a modifier key. When the Alt hardkey is pressed in conjunction with another key, it performs a special operation.

3. Main
Displays the active window of the PXB user interface. If the user interface is hidden behind the window of another application, pressing Main brings it to the front of the display.

4. Cancel (Esc)
Functions like the Escape hardkey. In the local mode, the Cancel (Esc) hardkey cancels tasks. In the remote mode, Cancel (Esc) functions as the Local hardkey. It deactivates remote operation and returns the instrument to front panel control.

5. Delete
Discards the character at the cursor's position, moving any following characters to the left to fill the empty spaces.

6. Numeric Keypad
The numeric keypad is comprised of the following: the numbers 0 through 9, a decimal point, a minus sign, space, and backspace keys.

7. Enter
Enables you to enter the values that you select for the measurement settings. Pressing Enter after entering data enables you to terminate editing. Pressing the Enter hardkey also activates selected (highlighted) menu items and keys.

8. (Up/Down Arrow Keys)
Enables you to move the cursor vertically through a table to select items for editing on the system's display.

9. (Left/Right Arrow Keys)
Enables you to move the cursor horizontally through a table to select items for editing on the system's display.
Front Panel Features

Front Panel

10. Touch On/Off
The touch screen default is on. The selection off or on is persistent through power cycles. When on, the touch screen works in the PXB and Windows with PXB minimized. When you press the Touch On/Off hardkey, the PXB user interface displays a message in the status bar indicating the status of the touch screen:
- Information, Touch screen is off
- Information, Touch screen is on

11. Keyboard
Launches the on screen keyboard from the front panel hardkey.

12. Preset
Resets the PXB user interface to a factory-defined state. The user interface automatically starts up in this factory-defined, default mode where one block is selected from the Generate category in the Configuration Browser, and its corresponding configuration is displayed on the Block Diagram tab.

13. Help
Opens the Agilent PXB online documentation help system.

14. System
Provides a shortcut to the PXB user interface System menu where you can view product information, set system clock and trigger settings, perform calibrations and self tests, and configure GPIB addresses.

15. Tab (Left)
Functions as the Shift + Tab combination of hardkeys. This hardkey enables you to navigate in the opposite direction of the Right Tab hardkey in order to edit or activate items in the loaded configuration.

16. Tab (Right)
Enables you to navigate through and edit or activate items in the loaded configuration. For example, in the Parameter View, pressing the Tab hardkey moves you to and selects the next item for the currently selected parameter. When you move to the parameter settings cell, the Tab hardkey automatically selects (highlights) the entire cell, allowing you to edit that parameter value.

17. RPG (Rotary Pulse Generator) Knob
Functions like a mouse wheel. Rotating the RPG knob increases or decreases a numeric value, moves the highlight to the next digit, character, or item in a list, or fast scrolls on large documents.

18. Power
Turns the PXB power on and off.
**Touch Screen Display**

The touch screen display eliminates the need for the external keyboard and mouse as the primary method of interacting with the PXB user interface. The touch screen can be used to perform all the same functions as the mouse by the use of your finger to select items on the screen.

1. Open the PXB user interface by clicking the **PXB MIMO Receiver Tester** icon on the desktop display.
2. To enable the touch screen display, press the **Touch On/Off** hardkey on the front panel of the PXB.

   The touch screen mode indicator is displayed on the lower status bar of the PXB user interface.

If your touch screen display seems inaccurate or unresponsive when using it, perform the touch screen display calibration. The procedure for performing the **Touch Screen Calibration**, is located in the **Basic Instrument Procedures** section of the online documentation.

**USB Connectors**

**19. USB Connectors**

The PXB has eight USB Type A 2.0 ports for connecting devices; four on the front panel and four on the rear panel (USB Slave). There are also two USB Type B ports on the rear panel which are used for connecting to the host ports of other computers through a USB interface cable. When the PXB is set up in this primary/secondary configuration, SCPI commands can be sent from the host computer to control the PXB. The main advantages of USB devices are the fast data transfer speeds. In addition, most devices can be "hot" connected and disconnected to your instrument at anytime.

The first time you plug a device into a USB port, Windows will report it is identifying the hardware, searching for the correct driver, and installing the driver (if it was found). If the USB device is moved to a different USB port, Windows will repeat the hardware and driver identification process.

**NOTE**  
If a USB device is not recognized, try unplugging it from the PXB and plugging it back in. If the PXB will not boot up, try removing all USB devices until the boot up process has completed.
Rear Panel

Figure 2-2 Rear Panel Connectors

1. EXT I/O CLK IN
2. EXT SYNC
3. EXT TRIG IN
4. EXT REF IN
5. 10 MHz OUT
6. 100 MHz SYS CLK OUT
7. I/O CLK OUT
8. MARKER OUT
9. AUX I/O
10. MONITOR
11. USB SLAVE
12. MONITOR
13. USB MASTER
14. LAN
15. GPIB
16. INTERCONNECT 1/2
17. eSATA
18. PCIe x4 FROM UPSTREAM
19. PCIe x4 TO DOWNSTREAM
20. USB MASTER
**System Clock Rear Panel Connectors**

1. **EXT I/O CLK IN**
   Not active – reserved for future use

2. **EXT SYNC**
   Not active – reserved for future use

3. **EXT TRIG IN**
   External input signal used to trigger an event
   - **Connector**: male SMB
   - **Impedance nominally**: 50 Ω
   - **Signal**: Voltage level: +3.3 V
   - **Damage Levels**: < 0 V and > +3.3 V

4. **EXT REF IN**
   Input for an external frequency reference signal
   - **Connector**: male SMB
   - **Impedance nominally**: 50 Ω
   - **Signal**: Voltage level: +900 mV p-p
   - **Damage Levels**: < 0 V and > +3.3 V

5. **10 MHz OUT**
   10 MHz reference output used to lock the frequency reference of other test equipment to the PXB
   - **Connector**: male SMB
   - **Impedance nominally**: 50 Ω
   - **Signal**: Voltage level: +2.0 V p-p
   - **Damage Levels**: < 0 V and > +3.3 V

6. **100 MHz SYS CLK OUT**
   100 MHz system clock output
   - **Connector**: male SMB
   - **Impedance nominally**: 50 Ω
   - **Signal**: Voltage level: +2.0 V p-p
   - **Damage Levels**: < 0 V and > +3.3 V

7. **I/O CLK OUT**
   Not active – reserved for future use
8. MARKER OUT
Not active – reserved for future use

9. AUX I/O
Not active – reserved for future use

10. AC Power Receptacle
The AC power cord receptacle accepts a three-pronged AC power cord that is supplied with the PXB. For details on line setting requirements and the power cord, see Line Setting Requirements on page 6.
Front and Rear Panel Features

Rear Panel

11. MONITOR
Allows connection of an external VGA monitor

12. USB SLAVE
Standard USB 2.0 ports, Type A connect to external peripherals such as a mouse, keyboard, printer, DVD drive, or hard drive

13. USB MASTER
USB 2.0 port, Type B USB TMC (test and measurement class) connect to an external PC controller to control the PXB and for data transfers over a 480 Mbps link

14. LAN
Network interface used to control the PXB remotely

15. GPIB
A General Purpose Interface Bus (GPIB, IEEE 488.2 GPIB) connection that can be used for remote operation

16. INTERCONNECT 1/2
Not active – reserved for future use

17. eSATA
This port provides connectivity to external eSATA Hard Disk Drive (HDD) storage devices to increase system file storage capacity. The eSATA HDD operate at 150 Mbytes per second (MB/s) or 300 MB/s eSATA rates. This is the physical layer speed for the serial data across the cable. The actual average transfer rate to the host memory or the HDD is lower.

**CAUTION**
A device connected to this port is *not* “hot” swappable. The PXB should be powered off before adding or removing the HDD. The device should be connected and powered on before the instrument and the PXB should be powered off before the device is powered down or disconnected.

A device plugged in or powered on while the Windows Operating System (OS) is running will *not* be recognized and will require restarting the Windows OS. Removing an active device will cause Windows OS errors.

18. PCIe x4 FROM UPSTREAM
Not active – reserved for future use

19. PCIe x4 TO DOWNSTREAM
Not active – reserved for future use
**20. USB MASTER**
Not active – reserved for future use

**I/O Board Connectors**

Figure 2-3  I/O Board Connectors

21. CLOCK IN
Not active – reserved for future use

22. TRG IN
Not active – reserved for future use

23. MKR OUT
Marker outputs for each I/O board port numbered 1, 3, and 4 (marker 2 is reserved for internal use)

<table>
<thead>
<tr>
<th>Connector</th>
<th>male SMB</th>
<th>Impedance nominally 50 Ω</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signal</td>
<td>Voltage level: +3.3 V</td>
<td></td>
</tr>
<tr>
<td>Damage Levels</td>
<td>&lt; 0 V and &gt; +3.3 V</td>
<td></td>
</tr>
</tbody>
</table>
24. CLOCK OUT
Not active – reserved for future use

25. DIGITAL BUS I/O
Digital bus connectors (channel 1 and 2) enable operation with other test equipment, such as the MXA signal analyzer, MXG signal generator, ESG signal generator, and digital signal interface module, via the digital bus cable (Agilent part number N5101-60003).

26. I+, Q+
Analog output, in-phase component of I/Q baseband signal from the internal baseband card

<table>
<thead>
<tr>
<th>Connector</th>
<th>male SMB</th>
<th>Impedance nominally 50 Ω</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signal</td>
<td>Voltage level: +2.0 Vp-p</td>
<td></td>
</tr>
<tr>
<td>Damage Levels</td>
<td>&lt; -15 V and &gt; +15 V</td>
<td></td>
</tr>
</tbody>
</table>

27. I–, Q–
Analog output which is 180 degrees out of phase for the I+ and Q+ outputs

<table>
<thead>
<tr>
<th>Connector</th>
<th>male SMB</th>
<th>Impedance nominally 50 Ω</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signal</td>
<td>Voltage level: +2.0 Vp-p</td>
<td></td>
</tr>
<tr>
<td>Damage Levels</td>
<td>&lt; -15 V and &gt; +15 V</td>
<td></td>
</tr>
</tbody>
</table>
3 Using the PXB

- Keys to Success with the PXB on page 32
- Administering User Accounts on page 36
- To Create a New Account on page 37
- To Change the User Account Properties on page 38
- Hard Drive Partitioning and Use on page 40
- Licensed Firmware on page 40
- Running Self Test on page 41
- PXB System Information on page 45
- Remote Desktop: Using the PXB Remotely on page 46
- Agilent Technologies Recovery System on page 53
- Returning the PXB to Agilent Technologies on page 57
- Removing Sensitive Data on page 57
Keys to Success with the PXB

In an effort to make your experience with the PXB as successful and effortless as possible, a variety of tips are listed below. A quick review of these tips prior to using the PXB will help with your success.

External Instrument Firmware

- Make sure the external instruments have the correct firmware revisions installed:
  - E4438C ESG signal generators (firmware version C.05.23 or later)
  - N5182A MXG signal generators (firmware version A.01.44 or later)
  - N9020A MXA signal analyzers (firmware version A.01.64 or later)

Power

- Make sure you have the correct C19 AC power cord. PXB power cords are unique on the PXB end.

Cables

- Many of the connectors on the PXB I/O cards are SMB. You'll need one to four SMB to BNC cables (Agilent part number 8121-1789) or adapters depending on your setup (differential analog I/Q output setups and markers require more SMB to BNC cables or adapters).
- Make sure all the cables are connected to the correct ports for your setup.

10 MHz Reference

- You must have the 10 MHz reference connected between external instruments and the PXB. Otherwise, you risk data underflow/overflow, which yields sub-optimal results.
- Make sure the PXB reference is correctly set to internal or external for your setup.

Digital I/O Bus

- Make sure the digital bus cables (Agilent part number N5101-60003) are correctly connected between the external instruments and the PXB.
- Verify that the digital bus cable connectors are securely locked on both sides and at both ends.
LAN and GPIB

Make sure the LAN or GPIB connection to the external instruments is working. It is important to note that the GPIB port must be either an input or an output. Therefore, you cannot control the PXB through a GPIB input, and then concurrently use the PXB to control an MXA or an MXG through the GPIB output. There are multiple ways that allow the PXB to be a listener and a talker concurrently:

- Use LAN for all instruments, so that this problem never arises.
- Use the PXB as the controller, so that the GPIB port is only an output. If you use the PXB as a GPIB controller, be sure to enable the interface in Agilent IO libraries. The PXB defaults to a slave instrument.
- Use mixed modes: LAN to PXB, then GPIB from PXB to external instruments.
- Use GPIB as the input to PXB, then USB-to-GPIB converters to connect PXB to external instruments.

PXB Firmware

There are two PXB executable icons on the desktop - one indicates simulation mode and the other uses real hardware.

- Use the mode that exercises the hardware (does not have "Simulation Mode" in its name).
- When the PXB powers up, it auto-starts PXB firmware.

PXB Licensing

To install licenses on the PXB, run the Agilent License Manager (ALM) from within the PXB.

- If you have a USB memory device with a PXB license file saved on it, the PXB will not automatically install the license.

PXB Unexpected Errors

If you encounter an unexpected error, do as instructed by the firmware.

1. Save the N5106A and InternalN5106A event logs:
   b. Open the event log for N5106A, choose Action, and click Save Log File As to save the file.
   c. Repeat step b for the InternalN5106A event log.

2. Report the problem to your Agilent representative with as much detail as possible when describing what was being done when the problem occurred.
Using the PXB
Keys to Success with the PXB

External Instruments

- The external instruments must be in a known state when the PXB is controlling them.
  - Before starting, preset the external instruments.
  - Make the external instrument settings from the PXB user interface, not from the external instrument front panel.

MXA as an RF Input Device

- You must set the attenuator to maximize dynamic range.
- Do not let the input power to multiple MXAs be widely different. A 20 dB difference is OK; a 50 dB difference is not because both are using the same settings and they do not have that much dynamic range in the digitizer.

MXG/ESG as an RF Output Device

- You must run a user IQ calibration on the MXG or ESG to minimize LO feedthrough.
- It is possible for the RMS of the signal to get so low due to the backoff required for Peak to Average Ratio of fading and noise, that LO feedthrough becomes a significant contributor to EVM and output power.
- A good I/Q calibration is critical to making accurate measurements.

MXG/ESG ALC Settings

- In general, the PXB works best with the ALC turned off in the signal generators.
- Having the ALC turned on only works when channel summing, noise, and fading are turned off.
- If you must turn the ALC on, you will have to route the markers manually in the signal generator user interface.

Power Calibration

- As a default, power calibration is set to Auto which means the power calibration is performed every time the waveform is played.
- Power calibration operates on the setup as currently configured. Specifically, if you are using fading or AWGN noise, make sure they are on and have their proper settings prior to initiating the power calibration.
- Any time you do anything that might increase or decrease the RMS value of the signal (at any point in the signal path) by more than 10 dB, re-run the power calibration.
MIMO Configurations

- Set all the output signal generators to the same power, the power of the highest signal in the group.
- The PXB provides power balancing between antennas so that the output power will be correct when measured with a power meter.

Play

- When you think the PXB is playing, check for the DIGBUS annunciator on the front panel of the ESG or MXG. If the annunciator is not displayed, one of the following is probably the issue:
  - The digital bus cable is not present or is not connected correctly.
  - The waveform is not actually playing.
  - The waveform output is directed at the wrong I/O port.
  - The incorrect firmware revision is installed in the signal generator.

Fader

- Check that the carrier frequency in the Fader Master Setup panel matches the carrier frequency of the RF source when using the fader.
  - These parameters are not automatically coupled and will cause Doppler errors if they are different.

Touch Screen

- If you want to use the touch screen, there is a Windows keypad for entering units. To open the keypad:
  - Select On-Screen Keyboard from the Tools menu.
  - With the PXB application as the active window, press the Keyboard hardkey on the front panel.
Administering User Accounts

The administration of user accounts is accessed through the User Accounts menu from the Windows task bar by clicking Start > Control Panel > User Accounts.

- Existing User Accounts on page 36
- To Create a New Account on page 37
- To Change the User Account Properties on page 38

Figure 3-1 User Accounts Main Menu

A person may be designated as the administrator and can configure the PXB to allow others to use the instrument with reduced permissions. These users can have use of the PXB but will not have the ability to perform all of the administrative functions.

Existing User Accounts

The following user accounts already exist on the PXB.

Default User Account
The PXB is shipped from the factory with the following default user name and password.

- User name: Instrument
- Password: measure4u (all lower case)

Agilent Technologies recommends that you change the user name and password. Although allowed by Windows, do not delete this account. The default user account has the same privileges as the administrator account.
Administrator Account

The PXB is shipped from the factory with an Administrator account.

- **User name**: Administrator
- **Password**: agilent4u (all lower case)

Agilent Technologies recommends that you change the password, but not the user name. This account is created by Windows and cannot be deleted.

Guest Account

This account allows any user name to be entered without a password and gain limited access to the PXB files. This account is created by Windows and cannot be deleted. It can be renamed. This account is turned off when the instrument is shipped. To turn on this account, refer to **Change the User Account Properties** on page 38.

To Create a New Account

You can set up the PXB users by name and grant various levels of access. This is particularly important when the PXB is remotely controlled or accessed over a LAN.

**NOTE**

You can create as many user accounts as you like. The user name is not case sensitive. The password is case sensitive.

**CAUTION**

Although allowed by Microsoft Windows XP, Agilent Technologies strongly recommends that all Administrator accounts be password protected. Internet viruses look for and exploit this condition.

1. Click **Create New Account**.

   **Figure 3-2 Name the new account**

   ![Create New Account](image)

2. In the **User Accounts** dialog box, enter a user name for this account and select **Next**.

   For this procedure, John Smith was entered as an example user name.
3. Select the account type for this user account.
   - Computer Administrator
   - Limited

4. Click Create Account.

To Change the User Account Properties

A user account can be removed, the password changed, or a new level of access can be granted. The Guest account may be turned on by clicking the Guest icon > Turn On the Guest Account.

1. Click Change an account

2. Click the account name, John Smith.
   This opens the Account Name dialog box (see Figure 3-5.)
3. Select the change you wish for this account.
   - Change the name
   - Change the password
   - Change the picture
   - Change the account type
   - Delete the account

   Each selection opens a dialog box and requires you to make your selection for the intended change of this account.

4. Click OK to confirm.
Hard Drive Partitioning and Use

The hard drive is divided into three partitions: C:, D:, and E:

- The C: partition contains the Windows XP operating system (OS) and the PXB firmware installed by Agilent Technologies. It is an open system wherein the installation of additional software is permitted. The installation and use of other software is not warranted, and may interfere with the operation of the PXB firmware. If a PXB repair is ever needed, the Agilent version (OS and PXB firmware) of the C: partition is the only part that is restored by the Agilent Recovery System Procedure on page 53. You will need to reload any other software that you have added in the PXB.

- The D: partition is reserved for data storage. The User Accounts that are configured by Agilent Technologies have their My Documents folder mapped to the D: partition. This is for the convenience of backing up the user-created waveforms or user-defined configuration on the D: partition or an external device. This allows you to restore the data if you ever need to replace the hard drive.

- The E: partition is reserved for Agilent Technologies’ use and contains the self test data and the log files of the last self test performed. Do not change or overwrite the files on this drive. This could cause your instrument to not meet specifications or, in the worst case, stop functioning correctly. Do not use this drive for data storage.

Licensed Firmware

The PXB has licensed firmware options installed that can be purchased at any time without requiring a download. For more information on licensing these measurement applications, refer to the Online Documentation on page 17.
Running Self Test

The PXB provides a method of performance verification that allows you to select any number of self tests. These self tests check the power supply voltages and clock signals on the baseband generator boards, the I/O boards, and the midplane board. Depending on the number of boards installed, the duration of the self tests may range from a few minutes up to 20 minutes. After the self tests are complete, it will report if the tests passed or failed along with the related measured values and self test limits.

1. In the PXB user interface, select **Self Test** from the **System** menu to open the **Self Test** dialog box.

   ![Figure 3-6 Opening Self Test](image)

2. Select the self tests that you want to run.

   ![Figure 3-7 Select a Group of Self Tests](image)
You may select:
- Individual self tests by selecting the check box for each test you want to run
- Groups of self tests (for example, all clock tests) by selecting the check box at the top of each group
- All self tests by selecting the Select All button near the bottom of the dialog box

If you want to remove selected tests from the list of self tests that will be run, you may remove:
- Individual self tests by clearing the check box for the test
- All self tests by selecting the Deselect All button near the bottom of the dialog box

3. Select Run to start the self tests.

A message is displayed indicating any unsaved configuration setups will be lost during the self test. If you want to save your configuration setup information, select the Cancel button and save the configuration using the File > Save As before running the self tests.

Figure 3-8 Warning Message
4. Select **OK** to start running the self tests.

**Figure 3-9 Running Self Test**

During the self tests, a status box is displayed showing the progress of the tests.

5. After completion, the self tests results are shown. The **Test State** column displays the status of each test, **Passed** or **Failed**.

**Figure 3-10 Self Test Pass/Fail Test State**
6. To view the self test details (for example, measured values, upper/lower self test limits, etc.), select a test then select the **Show Details** button.

**Figure 3-11 View Test Details**

<table>
<thead>
<tr>
<th>Sub Test Name</th>
<th>Lower Limit</th>
<th>Upper Limit</th>
<th>Value</th>
<th>Test Run State</th>
</tr>
</thead>
<tbody>
<tr>
<td>+12V</td>
<td>11.5</td>
<td>12.3</td>
<td>11.9486</td>
<td>Passed</td>
</tr>
<tr>
<td>+16.5V</td>
<td>14.5</td>
<td>17.0</td>
<td>16.2076</td>
<td>Passed</td>
</tr>
<tr>
<td>+5.2V</td>
<td>4.8</td>
<td>5.3</td>
<td>5.0618</td>
<td>Passed</td>
</tr>
<tr>
<td>+3.3V</td>
<td>3.1</td>
<td>3.5</td>
<td>3.3173</td>
<td>Passed</td>
</tr>
</tbody>
</table>

7. To save the test results as a text file (*.txt), click the **Save All Results** button and select a location where you want the file to be saved. The default location is the **Self Test** folder on the E: drive partition of the PXB.

8. To print the test results, open the saved file in the **Notepad** application (or another text editor) and print using the print function in the application.

9. To exit the **Self Test** dialog box, click the **Close** button.
PXB System Information

Locating the Computer Name

To connect a remote computer to the PXB, you need to know its “computer name” (machine name). You can view the computer name and other networking information by either of the following two methods.

Windows XP
1. Minimize the PXB user interface.
2. On the Windows task bar, click Start > right-click My Computer > Open.
3. Click View system information.
4. In the System Properties dialog box, click the Computer Name tab.
5. The name to the right of Full computer name is the computer name.

PXB User Interface
1. Restore the PXB user interface by clicking the PXB MIMO Receiver Tester icon on the Windows task bar.
2. In the PXB user interface, click System > Product Information.
3. In the System Information tab, the name to the right of Machine Name is the computer name.

Figure 3-12 Product Information Window

4. To exit the Product Information window, click Block Diagram.

Checking the IP Address

You can view the IP address and other networking information from the PXB user interface.

1. Select Product Information from the System menu (shown in Figure 3-6 on page 41) to view the System Information tab.
   
   The System Information tab lists the IP address and other system information. See Figure 3-12.
2. To exit the Product Information window, select Block Diagram.
Remote Desktop: Using the PXB Remotely

The Windows XP Remote Desktop Connection can be used for remote control of the PXB. It offers fully interactive control that is almost identical to the front-panel control of the PXB.

NOTE The Remote Desktop functionality is a Microsoft Windows XP feature. The following information provides guidelines for using this feature with the PXB. For more information, refer to the Microsoft Windows XP Help and Support documentation. Over time Windows functionality may change. Refer to the Microsoft website.

Overview of Remote Desktop Operation

The remote desktop functionality of the PXB allows you to control and interact with the PXB from a remote computer.

When you have configured the PXB for remote connectivity and configured a separate computer to act as a remote desktop host, you can control the PXB and view its display on the computer.

This section provides instructions of how to set up the PXB for remote connectivity and how to set up a computer running any 32-bit version of Microsoft Windows.

Setting Up Remote Desktop Operation

Setting Up the PXB

Before the PXB can be controlled with a Remote Desktop Connection, it must be set up to allow the connection.

NOTE To perform this operation, you must have Administrator level access to the PXB.

1. On the Windows task bar, click Start > Control Panel.
2. Select Performance and Maintenance > System.
3. In the **Systems Properties** dialog box, click the **Remote** tab.

4. In the **Remote Desktop** panel, click the **Allow users to connect remotely to this computer** checkbox.

5. To add users, click the **Select Remote Users...** and follow the on screen instructions and then select **OK**.

**Setting Up the Remote Computer**

This setup procedure depends on whether the remote computer is running Windows XP or another version of Microsoft Windows.

- If the remote computer is running Windows XP, the Remote Desktop Connection Client software is included. No additional setup is required.

- If the remote computer is running any 32-bit version of Windows (e.g. Windows 95, 98, ME, NT4.0, or 2000) that supports remote desktop connection, you will need to download and run the Remote Desktop Connection Client software from the Windows website.

**NOTE**  Agilent Technologies offers no warranty regarding the operation of such software.
Running a Remote Desktop Session

Initializing a Remote Desktop Session
To initialize a remote desktop session you need to know the computer name and the IP address of the PXB. For this information, refer to Locating the Computer Name and Checking the IP Address on page 45.

After setting up both the PXB and the remote computer for Remote Desktop Connectivity, as described in Setting Up Remote Desktop Operation, you are ready to start a Remote Desktop session.

1. Make sure the PXB MIMO Receiver Tester has been powered up and the PXB user interface has loaded.
2. From the remote computer, click Start > All Programs > Accessories > Communications > Remote Desktop Connection.
3. In the Remote Desktop Connection dialog box, enter the IP address of the PXB.

4. Click Connect.
5. Log in by entering the PXB’s user name and password. The default user name is instrument and the default password is measure4u (all lower case), but note that these parameters may have been changed by other users.

Figure 3-14 Remote Desktop Connection

Figure 3-15 Log On to Windows display
NOTE Only the current User or an Administrator can remotely log into the instrument. To see who the current user of the PXB is, press the Ctrl + Esc hardkeys on the instrument until you can view the current user name on the Start menu. If no one is currently logged into the instrument, any valid instrument user can remotely log in.

6. The PXB display appears on the screen of the remote computer. Most of the PXB functions can be accessed using the remote computer’s keyboard and mouse. In addition, there are some keyboard shortcuts that can be used to access some PXB front panel functions. See Keyboard Shortcuts for Remote Desktop Operation on page 52.

Setting Remote Desktop Options
These options are accessed in the Remote Desktop Connection dialog box as in Figure 3-14 by clicking Options.

Figure 3-16 Remote Desktop Connection Options – General
The Options menu has several tabs. Generally, the default settings are correct. However, there are some restrictions on particular settings under certain tabs, as listed below.

- Under the General tab, ensure that the Computer name, User name, and Domain name are correctly set.
- You may choose to enter the password and save it for future sessions, by checking the Save my password check box.

Figure 3-17  Remote Desktop Connection – Display Options
Under the Display tab the following options are available:

- In the Remote desktop size panel, you may select the size of the window in which the PXB display will appear. Do not select any size smaller than 1024 x 768 pixels. Selecting a remote desktop size smaller than 1024 x 768 results in the PXB display not being fully visible. In such circumstances, scroll bars do not appear, so portions of the display are not accessible.

- In the Colors panel, you may select any setting that use 15 bits or more. Selecting a color setting that uses less than 15 bits results in dithering and incorrect color rendition of the remote desktop window.

Figure 3-18 Remote Desktop Connection Experience Options

Under the Experience tab you have the following options:

- In the Performance panel, you can optimize the performance of the remote desktop session by choosing the appropriate connection format from the drop-down list box.

- You may also select any of the check boxes which you consider appropriate.

Ending a Remote Desktop Session

Disconnect the remote computer from the PXB to end the remote desktop session.

1. Select the IP Address Remote Desktop icon in the upper left corner of the Window’s title bar then select Close.

   A dialog box appears indicating Disconnect Terminal Services Session.

2. Click OK to confirm disconnect.
**Keyboard Shortcuts for Remote Desktop Operation**

When the PXB is in Remote Desktop mode, the following remote keyboard keys can be used to mimic the operation of the PXB front panel hardkeys. When using the PXB in Remote Desktop mode, the following remote keyboard keys can be used to mimic the operation of the PXB’s user interface File menu/toolbar.

<table>
<thead>
<tr>
<th>Front Panel Key Name</th>
<th>Remote Keyboard Equivalent</th>
<th>User Interface Command Name</th>
<th>Remote Keyboard Equivalent</th>
</tr>
</thead>
<tbody>
<tr>
<td>– (Minus Sign)</td>
<td>– (Minus Sign)</td>
<td>New Configuration</td>
<td>Ctrl + N</td>
</tr>
<tr>
<td>. (Decimal Point)</td>
<td>. (Decimal Point)</td>
<td>Recall</td>
<td>Ctrl + 0</td>
</tr>
<tr>
<td>← → (Left/Right Arrow Keys)</td>
<td>← → (Left/Right Arrow Keys)</td>
<td>Save</td>
<td>Ctrl + S</td>
</tr>
<tr>
<td>↑ ↓ (Up/Down Arrow Keys)</td>
<td>↑ ↓ (Up/Down Arrow Keys)</td>
<td>Print</td>
<td>Ctrl + P</td>
</tr>
<tr>
<td>0–9 (Number Keys)</td>
<td>0–9 (Number Keys)</td>
<td>Copy</td>
<td>Ctrl + C</td>
</tr>
<tr>
<td>Alt (Alternate)</td>
<td>Alt (Alternate)</td>
<td>Paste</td>
<td>Ctrl + V</td>
</tr>
<tr>
<td>Bk Sp (Backspace)</td>
<td>Backspace</td>
<td>Undo</td>
<td>Ctrl + V</td>
</tr>
<tr>
<td>Cancel (Esc)</td>
<td>Esc</td>
<td>Opens Keyboard Help</td>
<td>F1</td>
</tr>
<tr>
<td>Ctrl (Control)</td>
<td>Ctrl</td>
<td>Opens File Menu</td>
<td>F10</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enter</td>
<td>Enter</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Help</td>
<td>F1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Keyboard</td>
<td>Ctrl + Alt + K</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Main</td>
<td>Ctrl + Alt + M</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Preset</td>
<td>Ctrl + Alt + P</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RPG (Rotary Pulse Generator) Knob</td>
<td>none</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Space</td>
<td>Space Bar</td>
<td></td>
<td></td>
</tr>
<tr>
<td>System</td>
<td>Ctrl + Shift + Y</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tab (Left)</td>
<td>Shift + Tab</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tab (Right)</td>
<td>Tab</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Touch On/Off</td>
<td>Ctrl + Alt + T</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**NOTE** The effect of pressing **Ctrl + Alt + Delete** on the keyboard of the remote computer always applies to the remote computer, and not to the PXB. Generally, the effect of this hardkey combination is to display the Windows Task Manager. Therefore, pressing this hardkey combination on the remote computer does not reboot the PXB.
Agilent Technologies Recovery System

The Agilent Technologies Recovery System is used to recover from a serious malfunction caused by corrupted or missing files on the PXB's primary C: drive partition.

**CAUTION** The operating system recovery will overwrite the C: drive partition, restoring the instrument's operating system back to its original factory condition. After performing the recovery, any option upgrades, additional software, or user accounts added since purchase of the PXB are lost and need to be reinstalled.

Save any files, programs, or user data that you want to keep on the D: drive partition before running the operating system recovery. **My Documents** is mapped to the D: drive partition, which is designated for user data and will not be affected by the recovery process. Although the E: drive partition will not be affected by the recovery process either, it is not recommended that you store your data on this partition because it is designated for factory instrument calibration data.

**Agilent Recovery System Procedure**

1. Click **Start > Shut Down > Restart > OK**.
2. In the screen after the Agilent logo, when **Please select the operating system to start:** displays, press the **Down** arrow hardkey on the PXB front panel to highlight the **Agilent Recovery System** and then press **Enter**.

**Figure 3-21  Agilent Recovery System**

3. Press **Enter**.
4. To start the recovery process, select 2 (Recover Factory Backup Image) from the Recovery Options Menu, then press Enter.

Figure 3-22 Recovery Options Menu

5. When the following warning is displayed, press 1, then press Enter to continue.

Figure 3-23 Recovery Warning

6. When the following caution is displayed, press 1, then press Enter to continue.

Figure 3-24 Recovery Caution
The recovery process begins immediately and the progress is monitored as shown in Figure 3-25.

**Figure 3-25  Recovery Progress Indicator**

7. After the recovery process is complete, the following message is displayed.

**Figure 3-26  Recovery Process Completion Screen**
8. Press any key to continue. Upon rebooting, the instrument displays the following message:

Figure 3-27  Windows XP Professional Setup Wizard Message

9. Press **Enter** to continue the Windows XP Setup Wizard. Refer to *Initializing the System* on page 11 for information on starting the PXB for the first time.
Returning the PXB to Agilent Technologies

If you experience a problem with your PXB that you cannot correct and need to return the PXB to Agilent Technologies for repair, follow these steps to ensure your security and facilitate the repair of your instrument.

1. Gather as much information as possible about the PXB’s problem.

2. Remove sensitive proprietary information from the PXB (if required). Refer to Removing Sensitive Data.

3. Contact Agilent Technologies using the phone number that is specific to your geographic location. These phone numbers are listed on the internet at http://www.agilent.com/find/assist. If you do not have access to the Internet, contact your Agilent Technologies representative.

   After you provide the information about the PXB and its condition, you will receive information about where to ship your PXB for repair.

4. Ship the PXB in the original factory packaging materials, if available, or use similar packaging to properly protect the instrument.

Removing Sensitive Data

If your PXB has secure data on the hard drive and you need to move your PXB from your secure environment, you will need to remove the hard drive from the PXB.

For complete information, refer to the Agilent N5106A PXB MIMO Receiver Tester Security Features document (Agilent part number N5105-90014). All documentation is available on the internet at http://www.agilent.com/find/pxb. Always refer to this web site for the most recent and up-to-date documentation.
4 Using Microsoft Windows XP

- Microsoft Windows XP Considerations on page 60
- On Screen Keyboard on page 61
- User Installation of Software on page 61
- Capturing/Printing Displays and Windows on page 62
- Windows Security on page 62
- System Backup on page 62
Microsoft Windows XP Considerations
Agilent Technologies has modified and optimized the Microsoft® Windows® XP operating system to work with the PXB firmware and to control the hardware that performs the PXB functions. Heed the following instructions and avoid repairs:

- Do not modify or reconfigure the operating system.
- Do not install a standard version of the Windows operating system on the PXB.
- Do not change advanced performance settings or group policies.
- Do not add, change, or delete any Hard Disk Drive (HDD) partitions on the PXB.
- Do not delete the Agilent Technologies user account.
- Do not modify any of the Agilent Technologies Windows Registry entries.
On Screen Keyboard

Figure 4-1  On Screen Keyboard

The on screen keyboard is a graphical computer keyboard that enables you to touch or click (if using a mouse) the keys on a virtual keyboard. It functions like the external QWERTY keyboard, allowing you to enter text into any Windows or PXB application that accepts alphanumeric data. To launch the keyboard:

From Windows XP

- From the Windows task bar, click Start > All Programs > Accessories > Accessibility > On–Screen Keyboard.

From the PXB User Interface

- Select Tools > On Screen Keyboard.
- Press the front panel Keyboard hardkey.

The front-panel Keyboard hardkey functions only when the PXB user interface is running.

User Installation of Software

Installation of Third Party Software

The PXB is an open Windows environment so you can install software on the instrument, however, the installation of third party software may affect instrument performance. Agilent Technologies does not warranty the performance of the PXB with any third party software installed.

NOTE  Before installing any additional programs on the instrument, you should exit the PXB user interface.

Do not remove any factory installed applications or programs from the PXB.
Capturing/Printing Displays and Windows

This capture/print functionality is a Microsoft Windows XP capability. The following provides some guidelines for using this capability with the PXB. For more information, refer to the Microsoft Windows XP Help and Support documentation.

1. Capture the desired screen area:
   - To capture the image of the entire desktop, press the Print Screen key on an external keyboard. This saves the image on the Windows clipboard.
   - To capture the image of a single window, select the window and press the Alt + Print Screen keys on an external keyboard. This saves the image on the Windows clipboard.

2. Open a graphics software program on the PXB.
   Microsoft Paint is accessible on the PXB by selecting Start > All Programs > Accessories > Paint.

3. Press Ctrl + v keys to paste the clipboard contents into the graphics software.

4. Save the image to a file.
   If you save the file to a USB memory device, the saved graphic file can be easily transported from the PXB to a PC for use in other software applications.

5. From the graphics software, print the image.

Windows Security

Spyware Protection

There is no anti-spyware software installed on the PXB. To protect the instrument against security threats, pop-ups, and slow performance, it is recommended that you install anti-spyware software if you connect the PXB to the internet. If available, contact your IT department for assistance.

System Backup

It is recommended that a regular backup strategy be implemented. Contact your IT department for information on any existing backup system which is suitable for the PXB and its data.

Windows XP has a Backup utility that creates a copy of the information on your hard drive. In the event that the original data on your hard disk is accidentally erased or overwritten, or becomes inaccessible because of a hard disk malfunction, you can use the copy to restore your lost or damaged data. For more information on this utility, refer to the Microsoft Windows XP Help and Support documentation.

A third party backup utility which is compatible with the PXB system software may be used. For more information, refer to “Installation of Third Party Software” on page 61.

When performing a backup, it is recommended that the data be sent to an external storage device connected to the network or one of the instrument’s USB connectors.

**NOTE** If possible, schedule the backup at a time when the instrument is not being used for normal operations as it may impact the instrument's overall performance.
5 PXB Basic Configuration Setup

- **One Channel Generate Configuration Setup** on page 64
  - 1. Basic Introduction and Turn On on page 64
  - 2. External Instrument Registration on page 64
  - 3. External Instrument Assignment on page 66
  - 4. Baseband Generator Setup and Waveform Download on page 68
  - 5. Output I/O Setup on page 69
  - 6. Signal Generator Setup on page 71
  - 7. Waveform Playback on page 72
One Channel Generate Configuration Setup

This example configuration setup will step you through the 1 Channel Generate configuration, the most basic of the PXB configurations.

Figure 5-1  Block Diagram

This configuration is completed by following these seven procedures:
1. Basic Introduction and Turn On
2. External Instrument Registration
3. External Instrument Assignment
4. Baseband Generator Setup and Waveform Download
5. Output I/O Setup
6. Signal Generator Setup
7. Waveform Playback

Use these steps to complete most of the PXB setups. Slight variations may occur to complete other configuration setups. Learn about each configuration type in the "Tutorials and Example Configuration Setups" section located in the PXB online documentation.

Step-by-step instructions for completing each of these basic steps are provided in the following sections.

1. Basic Introduction and Turn On

When the PXB is powered on, it displays a 1 Channel Generate configuration in the Configuration Browser as the default. This configuration is available to all PXBs. The PXB only displays configurations that the PXB supports. These supported configurations are determined by the number of baseband cards, I/O cards, and licenses installed in the PXB.

1. To turn on the PXB, press the front panel Power hardkey.
2. Allow the PXB to boot up and display the PXB user interface.
3. Ensure that the 1 Channel Generate configuration is selected in the Configuration Browser.

   The block diagram for this selected configuration (shown in Figure 5-1) is displayed on the Block Diagram tab.

   For additional information on the Configuration Browser, refer to the Configuration Basics tutorial section in the online documentation.

2. External Instrument Registration

The PXB is designed to use a variety of external instruments to provide external inputs or receive the output of the PXB. These external instruments can be controlled by the PXB firmware; however, the external instruments must be registered within the firmware prior to being available for use.
This example will only require a signal generator (MXG or ESG). This process only needs to be performed once. If the instrument that you plan to use is already registered (see step 1), you may skip External Instrument Registration and proceed with the Configuration Selection.

1. Click the **External Instrument Table** tab to display the External Instrument Table.

   **Figure 5-2** shows the External Instrument Table that has been populated with several external instruments used with the PXB.

   The **External Instrument Table** displays the external instruments that are currently registered with the PXB firmware. External instruments that can be registered are:

   - N5182A MXG Signal Generators (used at the output of the PXB)
   - E4438C ESG Signal Generators (used at the output of the PXB)
   - N5102A Digital Signal Interface Module (DSIM) (used at the output of the PXB)
   - N9020A MXA Signal Analyzer [used at the input of the PXB for (ext in) configurations]

   The table displays the name, instrument type, address, and I/O Port of each registered external instrument. If no instruments are displayed in the table, then no instruments are currently registered.

   **Figure 5-2** **External Instrument Table**

<table>
<thead>
<tr>
<th>Name</th>
<th>Family</th>
<th>Address</th>
<th>Assigned to I/O Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>ESG1</td>
<td>ESG-C</td>
<td>GPIB0::19::INSTR</td>
<td></td>
</tr>
<tr>
<td>MXA1</td>
<td>MXA</td>
<td>TCP/IP::123.30.0.12::</td>
<td></td>
</tr>
<tr>
<td>MXG1</td>
<td>MXG</td>
<td>TCP/IP::129.26.034.17::</td>
<td></td>
</tr>
<tr>
<td>MXG2</td>
<td>MXG</td>
<td>TCP/IP::121.14.178.22::</td>
<td></td>
</tr>
<tr>
<td>N5102A #1</td>
<td>DSIM</td>
<td>N/A</td>
<td></td>
</tr>
</tbody>
</table>

2. Select the **Add** button to start the registration process. This displays the **Register External Instrument** dialog box. This procedure uses the N5182A MXG signal generator for example purposes.
PXB Quick Start Guide
PXB Basic Configuration Setup
One Channel Generate Configuration Setup

3. In the Name text box, enter "MXG1" or another name to describe your signal generator. For the remainder of this example, the signal generator is referred to "MXG1".

4. In the Family drop down list, select the instrument type that describes the instrument's family. In this case, select MXG.

5. In the Visa Interface drop down list, select the interface that the PXB will use to communicate with the instrument (TCPIP0 = LAN or GPIB0 = GPIB).

6. In the Address text box, enter the LAN or GPIB address specific to the instrument that you are registering.

7. Click OK to complete the registration. The External Instrument Table should now show the instrument that you just registered (an MXG, in this case).

8. Click the Block Diagram tab to return to the configuration block diagram that was originally displayed.

3. External Instrument Assignment

With the 1 Channel Generate configuration selected, you now will assign the external instrument.

1. Review the block diagram.

You will see a BB Gen1 block and an I/0 1 Port A1 block (this block is an output which connects to a signal generator). You will also see an Unassigned block which represents an unassigned block for an external instrument (the signal generator).

2. On the unassigned block, click the Assign External Instrument tab to display the dialog box.

3. In the Assign area of the dialog box, select the MXG signal generator that you registered
previously from the Instrument drop down list.

Figure 5-5 Assign External Instrument

4. In the To area, leave the I/O Port Name field set to the default selection. Ensure that the I/O Port Type field is set to Digital.
   - The I/O Port Name field allows you to select any available I/O port.
   - The I/O Port Type field allows you to select from two types of I/O port connections, digital or analog, for the ESG or MXG signal generators. For additional information, refer to the Assign External Instrument tutorial section in the online documentation.

5. Click OK to return to the block diagram. Note that the external instrument block now displays the selected signal generator.

6. Connect the PXB to the signal generator as shown.
   For the rear panel connector locations, refer to Rear Panel on page 24.

Figure 5-6 PXG to MXG

7. Select Load Configuration to load the PXB settings for each of the configuration blocks.
4. Baseband Generator Setup and Waveform Download

Once the configuration is loaded, the Settings Browser replaces the Configuration Browser at the left edge of the user interface. Each block from the block diagram is listed in the Settings Browser. You are now able to view and edit the setting for each block. Next, set up the baseband generator block and download a factory default waveform to play.

1. Open the baseband generator settings for BB Gen1. This can be done in one of two ways:
   - Select the BB Gen1 block in the block diagram
   - Select the BB Gen1 label in the Settings Browser

2. Notice the four tabs that are displayed: General Settings, Marker Generation, Power Control Settings, and Power Control Graphics.

Figure 5-7  Baseband Generator BB Gen1

Selecting a tab label displays the tab's settings. The General Settings are similar to those found in a traditional signal generator such as; Waveform Source Name, Sample Rate, Trigger Delay, and Baseband Frequency Offset.

3. With the General Settings tab selected, select Waveform Source Name to display the ellipsis button at the right edge of its settings cell.

Select the ellipsis button to display the Open File dialog box.

4. For this example, ensure the Default1.bin waveform is selected. This is the waveform that the baseband generator will play.

The Default1.bin waveform is 5000 samples, one cycle of a sine wave. It is a single tone that appears on the high side of the carrier with a frequency of (sample rate)/5000. For a sample rate of 100 MHz, the tone appears 20 kHz above the carrier frequency.

The default folder, C:\Program Files\Agilent\PXB\FactoryDefaultWaveforms, contains the factory default waveforms. For additional information regarding waveforms, refer to Factory
**Default Waveform Files** in the online documentation.

If you have already loaded other waveform files on the PXB, you can navigate to the folder it was saved in using the Open File dialog box.

5. Select the **Marker Generation** tab to review this tab's settings. For additional information regarding markers, refer to the **Marker Basics** tutorial in the online documentation.

6. Select the **Power Control Settings** tab to review this tab's settings. The **Power Control Graphics** tab provides a graphical description of some of the power control settings. For additional information regarding power control, refer to the **Power Management and AWGN** tutorial in the online documentation.

7. Select **Block Diagram** to return to the block diagram.

8. Select **Load Waveforms** (see Figure 5-8 on page 70) to display the **Waveform Table**.

   Even though the correct waveform is displayed for the BB Gen block, notice that **Waveform Status** is "Out-of-Date" and the **Download Status** is "Not Started" which indicates that the waveform has not been loaded to the baseband generator yet.

9. Select **Start** to actually download the designated waveform from the PXB hard drive to the playback memory of the baseband generator.

   Notice that, once the waveform has been downloaded, **Waveform Status** is displayed as "Up-to-Date" and **Download Status** is displayed as "Completed".

10. Return to the block diagram.

5. **Output I/O Setup**

   The output I/O port is used as the output interface to an external instrument (either a signal generator or an N5102A Digital Signal Interface Module) at the output of the PXB. The output I/O block has its own settings that are customized for the output. For additional information, refer to the **I/O Port Setup** tutorial in the online documentation.

1. Open the I/O Port settings for I/O1 Port A1. This can be done in one of two ways:

   - Select the **I/O1 Port A1** block in the block diagram
   - Select the **I/O1 Port A1** label in the **Settings Browser**

2. Notice the four tabs that are displayed: **General Settings**, **AWGN Settings**, **Marker Selection**, and **AWGN Graphics**.
The following is a quick review of how each of the tabs can influence the output of the PXB.

3. Review the **General Settings** tab.

   The General Settings tab provides information about the I/O port and can be used to make changes to the I/O port. You will notice that the Mode setting is a read-only entry that displays Output indicating that this I/O port is being used as an output I/O.

4. Select the **AWGN Settings** tab to review this tab's settings. This tab is used to add and control Additive White Gaussian Noise (AWGN) to the output signal at the I/O port. The **AWGN Graphics** tab provides a graphical description of some of the AWGN settings.

5. Select the **Marker Settings** tab to review this tab's settings. For additional information, refer to the **Marker Basics** tutorial in the online documentation.

   The I/O output block can pass the existing markers from the input source, the baseband generator or I/O input block, or can dynamically generate new markers based on the waveform present at the I/O output block. Markers that are generated from an output I/O block that is receiving a single-input waveform are merged with the waveform as it was received. Therefore, if the original waveform has had fading or interference added, the degraded waveform is used to generate these markers. This is important to note because dynamic markers use the values of the waveform samples to determine when markers are generated.

   Any output I/O markers are used instead of the markers previously embedded in the original waveform file or those generated by a user-created marker file or baseband generator block.

6. Return to the block diagram.
6. Signal Generator Setup

The PXB provides direct control of several of the signal generator settings. These settings include the output frequency, the output amplitude, and the internal marker routing and more. It does not provide control of all the signal generator settings.

1. Open the MXG settings for MXG1, the signal generator that we have assigned as the external instrument for this configuration. This can be done in one of two ways.

   - Select the MXG1 block in the block diagram
   - Select the MXG1 label in the Settings Browser

2. Notice that this external instrument has two tabs that are displayed: General Settings and Marker Routing.

3. Review the General Settings tab.

   The General Settings tab is comprised of three categories.

   - Basic Settings which provides control of basic signal generator settings
   - ALC Settings which provides control of the signal generator's Automatic Level Control (ALC) and attenuator circuitry
   - Power Search Settings which provides control of the signal generator's power search function when a power calibration is performed

4. Select the Preset button to preset the signal generator.

5. Set the RF Output parameter to On so the signal generator's RF Output connector will be on when the waveform is played.
6. Set the **ALC** parameter to **Off** so the signal generator’s ALC circuitry will not interfere with the power calibration when it is performed.

7. Select the **Marker Routing** tab to review this tab’s settings. This tab allows you to set up the markers to control the **Pulse/RF Blanking** and the **ALC Hold** features. The PXB will overwrite these settings based on the system configuration as necessary to provide accurate output power to the signal generator.

   For additional information, refer to the **Marker Basics** tutorial in the online documentation.

8. Return to the block diagram.

**7. Waveform Playback**

Once the PXB configuration is set you can calibrate the system power and play the waveform from the BB Gen block through the I/O block to the connected signal generator through the digital bus.

![Figure 5-10 Calibrate Power](image)

1. Select **Calibrate Power** to perform the power calibration based on the baseband generator block's **Power Control Settings** and the output I/O block's **AWGN Settings**.

2. Select the **Play** button to start playing the waveform from BB Gen1.

3. When you wish to stop playing the waveform, select **Stop**.

   - To save the waveform, select **File > Save**.
   - To recall the waveform, select **File > Recall**.
6 Safety and Regulatory Information

- Warnings, Cautions, and Notes on page 74
- General Safety Considerations on page 74
- Lifting and Transporting on page 74
- Instrument Markings on page 75
- Toxic or Hazardous Substance and Elements Table on page 76
- Regulatory Information on page 76
- Contacting Agilent Technologies on page 77
Warnings, Cautions, and Notes

The documentation for this product uses the following safety notations. Familiarize yourself with each notation and its meaning before operating the PXB.

**WARNING**  *Warning* denotes a hazard. It calls attention to a procedure which, if not correctly performed or adhered to, could result in personal injury or loss of life. Do not proceed beyond a warning note until the indicated conditions are fully understood and met.

**CAUTION**  *Caution* denotes a hazard. It calls attention to a procedure that, if not correctly performed or adhered to, could result in damage to or destruction of the PXB; or in the loss of a user’s settings or data. Do not proceed beyond a caution note until the indicated conditions are fully understood and met.

**NOTE**  *Note* calls the user’s attention to an important point or special information in the text.

General Safety Considerations

**WARNING**  If the PXB is not used as specified, the protection provided by the equipment could be impaired. The PXB must be used in a normal condition only, in which all means for protection are intact.

**WARNING**  Personal injury may result if the PXB covers are removed. There are no operator serviceable parts inside. To avoid electrical shock, refer servicing to qualified personnel.

Lifting and Transporting

The weight of the PXB can exceed 33 kg (70 lbs). The PXB should be lifted by at least two people. If two people are not available, use a mechanical lift to lift the PXB. The PXB should be transported using a rolling cart.

Weight and Dimensions

Weight: 33 kg (70 lbs.)

Dimensions (Height X Width X Depth):
- Centimeters: 21.9 cm X 42.5 cm X 59.1 cm
- Inches: 8 5/8” H X 16 3/4” W X 23 1/4” D
Instrument Markings

The PXB has the following markings. Familiarize yourself with each marking and its meaning before operating the PXB.

The instruction manual symbol. The product is marked with this symbol when it is necessary for you to refer to instructions in the manual.

The CE mark is a registered trademark of the European Community. If this symbol is accompanied by a year, it is the year when the design was proven.

The CSA mark is a registered trademark of the Canadian Standards Association International.

The C-Tick Mark is a trademark registered to the Australian Spectrum Management Agency. This indicates compliance with all Australian EMC regulatory information.

This is the symbol of an Industrial Scientific and Medical Group 1 Class A Product. (CISPER 11, Clause 4)

This symbol marks the on position of the power line switch.

This symbol marks the standby position of the power line switch.

This symbol indicates that the input power required is AC.

This is a marking to indicate product compliance with the Canadian Interference—Causing Equipment Standard (ICES-001)

This product complies with the WEEE Directive (2002/96/EC) marking requirements. The affixed label indicates that you must not discard this electrical/electronic product in domestic household waste.

Product Category: With reference to the equipment types in the WEEE Directive Annex 1, this product is classed as a “Monitoring and Control instrumentation” product.

Do not dispose in domestic household waste.

To return unwanted products, contact your local Agilent Technologies office.
EFUP (Environment–Friendly Use Period) indicates the time period during which no hazardous or toxic substances or elements are expected to leak or deteriorate during normal use and generally reflects the expected useful life of the product. The time period is stated in terms of the number of years, starting with the date of manufacture.

This product complies with the China standard GB18455–2001 packaging marking requirements. The ISO standard recycling symbol marking is used on all primary and secondary fibreboard packaging covered by China RoHS.

Toxic or Hazardous Substance and Elements Table
The PXB may contain replaceable assemblies or components (including the disk drive, power supply, mouse, display, or battery, which are not manufactured by Agilent Technologies) which have a shorter EFUP (Environment–Friendly Use Period) number than that which is indicated on the product itself (40 is indicated for the PXB). In cases where the assembly, component, or part is labeled with an EFUP which differs from the one indicated by Agilent Technologies, the EFUP on the assembly, component, or part takes precedence. Agilent Technologies makes no claims concerning, and takes no responsibility for the EFUP numbers reflected on goods which are not manufactured by Agilent Technologies.

Document part number 9320–6691 is the Toxic or Hazardous Substances and Elements Table and is shipped with each PXB.

Regulatory Information

Certification
Agilent Technologies certifies that this product met its published specifications at the time of shipment from the factory. Agilent Technologies further certifies that its calibration measurements are traceable to the United States National Institute of Standards and Technology, to the extent allowed by the Institute’s calibration facility, and to the calibration facilities of other International Standards Organization members.

Assistance
Product maintenance agreements and other customer assistance agreements are available for Agilent Technologies products. For assistance, contact Agilent Technologies.

Declaration of Conformity
A copy of the Manufacturer’s EU Declaration of Conformity for this instrument can be obtained by contacting your local Agilent Technologies sales representative.
Statement of Compliance

This product has been designed and tested in accordance with IEC Publication 61010, Safety Requirements for Electronic Measuring Apparatus, and has been supplied in a safe condition. The documentation contains information and warnings which must be followed by the user to ensure safe operation and to maintain the product in a safe condition.

Compliance with Canadian EMC Requirements

This ISM device complies with Canadian ICES–001.

Cet appareil ISM est conforme a la norme NMB du Canada.

Compliance with Canadian Standards Association Requirements

This product complies with CSA 1010 Edition 2.

Compliance with German Noise Requirements

This is to declare that this instrument is in conformance with the German Regulation on Noise Declaration for Machines (Laermangabe nach der Maschinenlaermrerordnung –3.GSGV Deutschland).

<table>
<thead>
<tr>
<th>Acoustic Noise Emission/Geraeuschemission</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>LpA &lt; 70 dB</td>
<td>LpA &lt; 70 dB</td>
</tr>
<tr>
<td>Operator position</td>
<td>am Arbeitsplatz</td>
</tr>
<tr>
<td>Normal position</td>
<td>normaler Betrieb</td>
</tr>
<tr>
<td>per ISO 7779</td>
<td>nach DIN 45635 t.19</td>
</tr>
</tbody>
</table>

Contacting Agilent Technologies

For assistance with test and measurements needs, information on finding a local Agilent Technologies office, and information on purchasing accessories and documentation, refer to:

http://www.agilent.com/find/assist

If you do not have access to the Internet, please contact your Agilent Technologies representative.

NOTE Prior to contacting Agilent Technologies be prepared with the PXB's model number and full serial number. This information is provided to the Agilent Technologies representative in order to determine the instrument's warranty period.
Index

Numerics
1 Channel Generate configuration, 64
10 MHz Out connector, 25
10 MHz reference, 32
100 MHz Sys Clk Out connector, 25

certification, 76
checking the shipment, 2
cleaning
  connectors, 17
  instrument cover, 17
touch screen display, 16
clock in connector, 28
clock out connector, 29
computer name, determining the, 45
configuration setup, 1 channel generate
  baseband generator setup & waveform download, 68
  external instrument assignment and setup, 66
  external instrument registration, 64
  output I/O setup, 68
  signal generator setup, 71
turn on and basic introduction, 64
  waveform playback, 72
connecting
  keyboard, 8
  monitor, 8
  mouse, 8
connectors
  cleaning, 17
  rear panel, 24–29
  USB, 23, 27, 28
contacting Agilent, 77
contents, 2
CPU host controller connectors, 27–28
eSATA connector, 27
GPIB connector, 27
interconnect 1/2 connector, 27
LAN connector, 27
monitor connector, 27
PCIe x4 From Upstream connector, 27
PCIe x4 To Downstream connector, 27
USB master connector, 27, 28
USB slave connector, 27
CSA compliance, 77
C-tick mark, 75
customer assistance agreements, 76

certification, 76
data security, 57
data sheet, 3
declaration of conformity, 76
desktop operation, remote, 46
digital bus
  cable, 3
  I/O connector, 29
digital I/O bus, 32
dimensions, 74
display, cleaning the touch screen, 16
display, touch screen, 23, 35

PXB Quick Start Guide
Index

documentation, 17
  list of, vii
  ordering, 3

E
E4438C ESG signal generator firmware requirements, 8
electrical requirements, 6
environmental requirements, 6
Environment-Friendly Use Period (EFUP), 76
equipment rack installation, 7
error messages documentation, vii
ers, unexpected PXB, 33
eSATA connector, 27
ESG
  ALC settings, 34
  as an RF output device, 34
  firmware requirements, 8, 32
European Community trademark, 75
Ext
  I/O Clk In connector, 25
  Ref Out connector, 25
  Sync connector, 25
  Trig In connector, 25
external instrument, 34
  assignment, 66
  connection diagrams, 9
  connections, 8
  firmware requirements, 8, 32
  registration, 64
external reference cable, 3

F
fader, 35
firewalls, 13
firmware, 33
  licenses, 15
  option, licensing, 40
  requirements for external instruments, 8, 32
  upgrade guide, vii
frequency requirements, 6
front handles, 3
front panel, 20–23
  hardkeys
    0-9, 21
    Alt (Alternate), 21
    Bk Sp (Backspace), 21
    Cancel (Esc), 21
    Ctrl (Control), 21
    Decimal Point, 21
    Delete, 21
    Enter, 21
    Help, 22
    Keyboard, 22
  Left/Right Arrows, 21
  Main, 21
  Minus Sign, 21
  Numeric Keypad, 21
  Power On/Off, 22
  Preset, 22
  RPG, 22
  Space, 21
  System, 22
  Tab (Left), 22
  Tab (Right), 22
  Touch On/Off, 22
  Up/Down Arrows, 21
touch screen display, 23
  USB connectors, 23

G
German noise requirements, 77
GPIB, 33
GPIB connector, 27
guided service and support, vii

H
handles, 3
hazardous substance and elements table, 76
Help documentation, 17
hostname, determining the, 45
humidity requirements, 6

I
I- Q- analog outputs, 29
I/O board connectors, 28–29
  clock in, 28
  clock out, 29
  digital bus I/O, 29
  I- Q- analog outputs, 29
  I+ Q+ analog outputs, 29
  mkr out, 28
  trg in, 28
I/O Clk Out connector, 25
I+ Q+ analog outputs, 29
ICES symbol, 75
ICES-001, 77
IEC Publication 61010, 77
image recovery, restoring to factory default, 53
inspection, shipping container, 2
installation in an equipment rack, 7
instrument
  dimensions, 74
  power option, 13
  weight, 2, 74
intellectual property security, 57
interconnect 1/2 connector, 27
interconnections, external equipment, 8
IP address, checking the, 45
ISM1-A symbol, 75

K
keyboard
  connecting a, 8
  on screen, 61
  remote desktop shortcuts, 52
keys to success with the PXB, 32–35
  10 MHz reference, 32
cables, 32
digital I/O bus, 32
external instrument firmware, 32
external instruments, 34
fader, 35
LAN and GPIB, 33
MIMO configurations, 35
MXA as RF input device, 34
MXG/ESG ALC settings, 34
MXG/ESG as RF output device, 34
play, 35
power, 32
power calibration, 34
PXB firmware, 33
PXB licensing, 33
PXB unexpected errors, 33
touch screen, 35
keys, front panel, 20–22
knob, 22

L
LAN, 33
  connections, 15
  connector, 27
licensed firmware options, 40
licensing, 15, 33
lifting the PXB, 74
line setting requirements, 6

M
maintenance agreements, 76
manuals, ordering, 3
Marker Out connector, 26
MIMO configurations, 35
mkr out connector, 28
monitor connector, 27
monitor, connecting a, 8
mouse, connecting a, 8
MXA, 34
  firmware requirements, 8, 32
MXG
  ALC settings, 34
  as RF output device, 34
  firmware requirements, 8, 32

N
N5182A MXG signal generator firmware requirements, 8
N9020A MXA signal analyzer firmware requirements, 8
noise requirements, 77

O
on screen keyboard, 61
online documentation, 17
options
  baseband hardware, 4
  built-in firmware, 4
  hardware/firmware bundle, 4
  I/O hardware, 4
  licensed firmware, 40
  PXB, 4
  software bundle, 4
  upgrade, 4
output I/O setup, 69

P
pass/fail testing, self test, 41
password setup, 36
PCIe x4 From Upstream connector, 24, 27
PCIe x4 To Downstream connector, 27
playing the waveform, 35
power, 32
  calibration, 34
  connecting, 7
cord, removing the, 14
disconnecting, 7
line cord, 7
on, initial, 11
option settings, 13
receptacle, 26
requirements, 6
symbol, 75
turning off the PXB, 14
power-up self test, 13
protection, spyware, 62
PXB
  firmware, 33
  licensing, 33
  to external equipment interconnections, 8
  unexpected errors, 33
R
rack mount kit, 3
rack, installation in an equipment, 7
Index

rear panel connectors, 24–29
AC power receptacle, 26
CPU host controller
eSATA, 27
GPIB, 27
interconnect 1/2, 27
LAN, 27
monitor, 27
PCle x4 From Upstream, 27
PCle x4 To Downstream, 27
USB master, 27, 28
USB slave, 27
I/O board
clock in, 28
clock out, 29
digital bus I/O, 29
I- Q- analog outputs, 29
I+ Q+ analog outputs, 29
mkr out, 28
trg in, 28
System Clock
10 MHz Out, 25
100 MHz Sys Clk Out, 25
Aux I/O, 26
Ext I/O Clk In, 25
Ext Ref Out, 25
Ext Sync, 25
Ext Trig In, 25
I/O Clk Out, 25
Marker Out, 28
recovery procedure, 53–56
regulatory information, 73
remote desktop
keyboard shortcuts, 52
overview, 46
running a remote desktop session, 48
setting options, 49
setup, 46
remove sensitive data, 57
removing power cord, 14
requirements, electrical and environmental, 6
returning the PXB, 57
RF input, 34
RF output device, 34
self test, power-up, 13
sensitive data, removing, 57
service documentation, vii
service, Agilent sales and service offices, 77
setup
ESG to PXB, 9
external instrument, 8
MXA to PXB to ESG, 9
MXG to PXB, 9
PXB to Digital Signal Interface Module, 10
PXB to ESG Analog I/Q, 10
shipping container, inspection, 2
shipping requirements, 57
shut down
power off, 14
using the Power hardkey, 14
with mouse, 14
signal analyzer firmware, 8
signal generator firmware, 8
signal generator setup, 71
software
anti-virus, 13
customer installed, 61
third party, 61
spyware protection, 62
standby symbol, 75
support documentation, vii
system backup, 62
system clock rear panel connectors, 25–26
10 MHz Out connector, 25
100 MHz Sys Clk Out connector, 25
AC power receptacle, 26
Aux I/O connector, 26
Ext I/O Clk In connector, 25
Ext Ref Out connector, 25
Ext Sync connector, 25
Ext Trig In connector, 25
I/O Clk Out connector, 25
Marker Out connector, 26
system recovery procedure, 53–56
T
temperature requirements, 6
test, self, 41
touch screen display, 23, 35
cleaning the, 16
toxic or hazardous substance and elements table, 76
transporting the PXB, 74
trg in connector, 28
trigger input cable, 3
turn off PXB, 14
turn on, 1 channel generate configuration, 64

82 PXB Quick Start Guide
Index

U
unexpected errors, 33
unpacking, 2
unplug, 14
USB connectors, 23, 27, 28
user accounts, administering, 36–39
account setup, 36
adding new accounts, 37
changing accounts, 38
existing accounts, 36
password setup, 36

V
ventilation requirements, 6
virus protection, 13
voltage requirements, 6

W
warnings, 74
waveform download, 68
waveform playback, 72
weight, 2, 74
Windows security, 62

X
XP considerations, 80